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Глава  2
ОСНОВЫ АНИМАЦИИ

§ 6. Основные понятия. Редактор для создания анимации

Самый ранний образец анимации 
создан примерно 5000 лет назад. Он 
представлен на кубке из необожжен-
ной глины, обнаруженном во время 
раскопок в Иране. На кубке изобра-
жена коза, которая подпрыгивает и 
срывает листья с пальмового дерева.

Каждое отдельное изображение 
козы на кубке представляет собой 
отдельный кадр.

В 1877 г. было запатентовано изоб-
ретение француза Шарля-Эмиля 
Рейно  (1844—1918) — праксиноскоп.

Шарль-Эмиль 
Рейно

Праксиноскоп

Праксиноскоп представлял со-
бой устройство из открытого цилин-
дра, в центре которого находилась 
зеркальная призма. Число граней 
призмы соответствовало количеству 
изображений-миниатюр. При бы-
стром вращении цилиндра на види-
мой грани призмы создавалась ил-
люзия движения.

6.1. Анимация. Виды анимации

Человек с древности пытался запе-
чатлеть движение в рисунке. Сегодня 
движение изображений можно видеть 
в мультфильмах, в видеофильмах, в 
рекламных баннерах на веб-страницах 
и др. А слово анимация известно даже 
маленьким детям. 

Анимация (от лат. animare — 
оживить) — процесс изменения раз-
мера, положения, цвета или формы 
объекта с течением времени.

Анимация представляет собой по-
следовательную демонстрацию серии 
изображений (кадров). Кадр отобража-
ется некоторое время, после чего исче-
зает, а на его месте появляется новый.
Кадры — изображения последова-

тельных фаз движения объектов или 
их частей.

Анимация основана на свойстве че-
ловеческого зрения «помнить» изобра-
жение в течение некоторого времени, 
после того как наблюдение прекра-
щается. Чем больше кадров содержит 
анимация, тем более сглаженным будет 
движение в процессе ее проигрывания. 
Для создания иллюзии непрерывного 
движения частота смены кадров долж-
на быть не менее 12 кадров в секунду.

Первоначально, при подготовке кад-
ров для анимации, каждый кадр рисо-
вался отдельно и полностью, что отни-
мало много времени даже у большого 
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коллектива художников. Затем стала 
использоваться послойная техника ри-
сования объектов и фонов на прозрач-
ных пленках, накладываемых друг на 
друга. Это снизило трудоемкость работ, 
т. к. не нужно было рисовать каждый 
кадр полностью. Современные анима-
ционные технологии переведены на 
компьютерную основу.

Компьютерная анимация — соз-
дание анимации с помощью компью-
тера.

Работая над созданием компьютер-
ной анимации, художник обычно про-
рисовывает начальное и конечное по-
ложение движущихся объектов, а все 
промежуточные состояния рассчитыва-
ет и изображает компьютер. Объекты 
компьютерной анимации размещаются 
на разных слоях (подобно прозрачным 
пленкам в классической анимации).

При создании компьютерной анима-
ции могут использоваться растровые 
изображения (Gif-анимация) и вектор-
ные рисунки (Flash-анимация).

Выделяют два способа создания 
компьютерной анимации: 

  покадровая анимация;
  расчетная анимация — анимация 

движения объектов и анимация формы.
При создании покадровой анима-

ции прорисовываются все фазы движе-
ния объекта. Такая технология незаме-
нима при создании сложной анимации 
с разнообразной графикой.
Анимация движения или формы 

предполагает рисование только от-
дельных кадров. В этих кадрах объект 
располагается в начале и в конце дви-

Уолт Дисней Н. Н. Константинов

Послойную технику в мультиплика-
ции впервые применил Уолт Дисней 
(1901—1966) — американский худож-
ник-мультипликатор, основатель ком-
пании Walt Disney Productions.

В 1968 г. группа советских уче-
ных во главе с Николаем  Нико-
лаевичем  Константиновым (со-
ветским и российским математиком, 
род. в 1932 г.) создала математиче-
скую модель движения животного. 
Вычислительная машина БЭСМ-4, 
выполняя программу, прорисовыва-
ла кадры мультфильма с анимацией 
движений кошки. Для создания ки-
нопленки с мультфильмом каждый 
кадр был распечатан на принтере, 
роль пикселя играла буква «Ш».

В настоящее время существуют 
различные технологии создания ком-
пьютерной анимации. Например:

  Запись движения. Актеры в спе-
циальных костюмах с датчиками 
совершают движения, которые за-
писываются камерами и анализи-
руются специальным программным 
обеспечением. Итоговые данные о 
перемещении суставов и конечностей 
актеров применяют к трехмерным 
скелетам виртуальных персонажей, 
благодаря чему добиваются высокого 
уровня достоверности их движения.

  Процедурная анимация полно-
стью или частично рассчитывается 
компьютером.

  При программируемой анима-
ции движения объектов программи-
руются с помощью браузерного язы-
ка JavaScript и языка работы с Flash-
приложениями ActionScript.

Правообладатель Народная асвета



29§ 6. Основные понятия. Редактор для создания анимации

жения. Все остальные кадры — проме-
жуточные. Изображение в них создает 
компьютерная программа, которая вы-
числяет, где и в какой момент должен 
находиться объект. Расчетная анима-
ция используется для создания анима-
ционных эффектов на веб-страницах, а 
также при создании рекламных, учеб-
ных и развлекательных фильмов.

6.2. Редактор Flash

Появлению компьютерной анима-
ции способствовало развитие программ 
для работы с графикой.

Программы для работы с анимацией 
представлены в примере 6.1. Одним из 
наиболее популярных редакторов для 
создания анимации является Flash. 
Преимущество Flash в том, что с его 
помощью можно создать красивую ани-
мацию, а файлы будут небольшого раз-
мера. Редактор Flash имеет интерфейс, 
многие элементы которого знакомы 
вам по опыту работы в графических 
редакторах (см. Приложение 2, с. 156).

В начале работы в редакторе необхо-
димо создать новый документ (File → 
→ New...) либо открыть уже существу-
ющий (File → Open...). 

Документ, созданный в Flash, приня-
то называть фильмом. В окне редактора 
Flash можно одновременно открывать 
несколько файлов с фильмами. Вклад-
ки открытых файлов располагаются 
под строкой меню: .

Для перехода к нужному файлу до-
статочно щелкнуть мышью по вкладке 
с его именем. Звездочка справа от име-
ни файла обозначает, что в нем сдела-
ны изменения, которые не сохранены.

Пример 6.1. Для создания аними-
рованных изображений существует 
множество программ, как платных, 
так и бесплатных. Например:

Vectorian Giotto

Adobe Animate

Easy GIF Animator

Pivot Stickfigure 
Animator

История Flash началась в 1996 г., 
когда компания Macromedia выпу-
стила продукт под названием Flash. 

В 2005 г. вышла версия Macromedia 
Flash Professional 8. В этой версии 
улучшена работа с графикой и ани-
мацией. В том же году фирма Adobe 
купила Macromedia вместе с ее про-
дуктами, включая Flash.

Значки различных версий редак-
тора Flash:

Macromedia Flash 
MX 2002

Macromedia Flash 
Professional 8 2005

Adobe Flash 
Professional CC 2015

Для устройств, которые не под-
держивают Flash, можно сохранить 
фильм в форматах HTML и GIF. В 
этом случае мультипликация может 
быть воспроизведена практически на 
всех устройствах.

Редактор Flash поддерживает язык 
сценариев (описания поведения объ-
екта) ActionScript. Используя этот 
язык, можно создавать интерактив-
ные (содержащие элементы взаимо-
действия с пользователем) фильмы.
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В левой части окна редактора Flash 
располагается Панель инструментов, 
состоящая из четырех разделов:

  Инструменты (Tools) — инструмен-
ты рисования и редактирования; 

  Просмотр (View) — способ просмо-
тра;

  Цвета (Colors) — цвета обводки и 
заливки;

  Параметры (Options) — настройка 
свойств выбранного инструмента.

(Рассмотрите пример 6.2.)
В рабочей области редактора Flash 

можно выполнять операции создания 
и редактирования объектов (см. Прило-
жение 2, с. 156). В кадр попадают толь-
ко те объекты, которые расположены в 
пределах монтажного стола. Осталь-
ная часть рабочей области нужна для 
предварительных рисунков и для реа-
лизации эффекта постепенного входа 
объекта в кадр (или выхода из кадра).

Размеры монтажного стола можно 
изменить (пример 6.3) в окне Свойства 
документа (Document Properties). 

Над рабочей областью находится 
шкала времени и список слоев (при-
мер 6.4). Шкала времени (Timeline) 
предназначена для работы с кадрами. 
Слои (Layers) — компьютерный аналог 
прозрачных пленок, которые применя-
ются в традиционной мультипликации.

В правой части окна размещаются 
дополнительные панели (пример 6.5).

Редактор Flash поддерживает век-
торную графику, однако позволяет ис-
пользовать и растровые изображения, 
импортированные из внешних файлов. 
При сохранении фильма в редакторе 
Flash обычно используют два типа фай-
лов: .fla и .swf. Собственным форматом 

Пример 6.2. Разделы Панели ин-
струментов редактора Flash.

Пример 6.3. Изменение размеров 
монтажного стола.

Пример 6.4. 

Шкала времени

Список слоев
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Flash является формат FLA. В этом 
формате фильм сохраняется для после-
дующего редактирования. Для реализа-
ции возможности просмотра фильма его 
нужно опубликовать.
Публикация — сохранение фильма 

в формате SWF. Опубликовать файл 
можно, выполнив команду Файл → 
→ Опубликовать (File → Publish) или 
с помощью комбинации клавиш Ctrl + 
+ Enter. Файл при публикации сохра-
няется в папку, в которой находится 
файл формата FLA. Опубликованный 
фильм можно просмотреть в любом про-
игрывателе Flash, а также в браузере.

Редактор Flash позволяет экспор-
тировать результаты работы в другие 
форматы. Для этого необходимо выпол-
нить команду Файл → Экспорт → Экс-
порт фильма (File → Export → Export 
Movie) и выбрать формат файла (при-
мер 6.6).

Пример  6.5.  Дополнительные 
панели.

1.  Что называют анимацией?
2.  Что представляет собой кадр?
3.  С какой минимальной частотой должна происходить смена кадров, чтобы соз-
давалась иллюзия непрерывного движения?
4.  В чем заключается покадровая анимация?
5.  Чем расчетная анимация отличается от покадровой?
6.  В каком формате нужно сохранить фильм, чтобы его можно было редактировать?
7.  Что значит опубликовать фильм?

Упражнения

   Откройте редактор Flash. Создайте новый документ. Используя материал § 6 
и Приложения 2 (с. 156), изучите интерфейс окна редактора. Выполните:

1. В меню выберите Вид → Сетка → Показать сетку (View → Grid →
→ Show Grid). Как изменилась страница в Рабочей области?
2. Установите размеры монтажного стола .

3. Изучите инструменты раздела Просмотр (View) на Панели инстру-
ментов. С помощью инструмента Рука (Hand Tool) ( ) переместите 
страницу в Рабочей области. Увеличьте видимый размер страницы и 

?

Пример 6.6. Экспорт файлов.

Смеситель цветов 
(Color Mixer)

Библиотека 
(Library)
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уменьшите его с помощью инструмента  Лупа (Zoom Tool). Настрой-

те увеличение (уменьшение) масштаба в разделе Параметры ( ).
4.  Откройте (закройте) дополнительные окна Смеситель Цветов и Би-
блиотека.

   Откройте в редакторе Flash файл. Сохраните файл под новым именем. Выполни-
те публикацию фильма. Просмотрите фильм в проигрывателе Flash.

§ 7. Создание изображений и редактирование объектов

Пример 7.1. Рисование линий.

        
Перед рисованием линии на Пане-

ли свойств выбрать:

1.  Толщину: 
2.  Цвет: 

7.1. Создание изображений

Основным анимируемым объектом 
редактора Flash является векторное 
изображение. Создание векторных изоб-
ражений в Flash имеет много общего с 
аналогичным процессом в векторных 
редакторах. Рассмотрим особенности 
использования инструментов рисова-
ния редактора Flash.

Для рисования линий в редакто-
ре Flash используется инструмент  
Линия (Line). Определить цвет, стиль 
и толщину можно на Панели свойств 

(пример 7.1). Линии с углом наклона, 

кратным 45°, рисуются при нажатой 
клавише Shift. 

Овал можно нарисовать с помощью 
инструмента  Овал (Oval). Этот ин-
струмент также используется для рисо-
вания круга и окружности (при нажа-
той клавише Shift).

Для рисования прямоугольников ис-

пользуют инструмент  Прямоуголь-
ник (Rectangle). Чтобы задать радиус 
закругления углов прямоугольника, 
нужно на Панели инструментов в раз-
деле Параметры выбрать  и в диа-
логовом окне Настройки прямоуголь-
ника (Rectangle Settings) ввести зна-
чение радиуса в пикселях (пример 7.2).

3.  Стиль:

Пример 7.2. Рисование прямо-
угольника с закругленными углами.

Пример 7.3. Диалоговое окно Tool 
Settings.
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Для рисования многоугольников и 
звезд нужно выбрать инструмент  
Многоугольник/Звезда (PolyStar), раз-
вернув список инструмента :

Когда инструмент  активен, на 
Панели свойств находится кнопка 

, которая вызывает окно на-
стройки инструмента (пример 7.3). В нем 
можно выбрать тип фигуры (много-
угольник/звезда), задать количество сто-
рон (лучей) и их размер (пример 7.4).

Для рисования линий и кривых ис-
пользуется инструмент  Перо (Pen) 
(пример 7.5). С помощью этого инстру-
мента легко рисовать ломаную линию. 
Щелчками мыши рисуется отрезок 
или контур, состоящий из отрезков 
прямых линий, соединенных угловы-
ми (опорными) точками.

Для рисования контуров произволь-
ной формы используется инструмент 

 Карандаш (Pencil). Для инструмен-
та Карандаш можно выбрать различ-
ные режимы рисования (пример 7.6):

  Выпрямление (Straighten) позво-
ляет преобразовать исходное изобра-
жение в одну из геометрических фигур 
(пример 7.7);

  Сглаживание (Smooth) сглажива-
ет линии. Степень сглаживания линий 
задается на Панели свойств в поле 

;

  Рисунок чернилами (Ink) похож на 
режим Smooth. Степень сглаживания 
незначительна и не изменяется.

Пример 7.4. Рисование много-
угольников и звезд.

Пример 7.5. Рисование ломаной 
линии инструментом Перо.

Пример 7.6. Выбор режима рисо-
вания для инструмента Карандаш.

Пример 7.7. Использование ин-
струмента Карандаш в режиме Вы-
прямление.

Во время 
рисования

После завершения 
рисования
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 7.2. Редактирование изображений

При подготовке кадров анимации 
приходится редактировать существую-
щие объекты. Свойства обводки и за-
ливки (цвет, форма, взаимное располо-
жение) могут изменяться пользователем 
независимо друг от друга. Заливку и 
обводку можно удалять по отдельности.

Прежде чем выполнить какие-либо 
действия с объектом, его необходимо 
выделить. Редактор Flash обладает 
большим спектром инструментов вы-
деления (пример 7.8). Основной ин-
струмент выделения —  Выбор 
(Selection). С его помощью можно выде-
лить весь объект, заключив его в прямо-
угольник. Тот же результат получит-
ся, если выполнить двойной щелчок 
по объекту. Несколько объектов выде-
ляются при нажатой клавише Shift. 
Выделенный объект покрывается мел-
кой сеткой. Щелчком можно выделять 
заливку или обводку по отдельности 
(пример 7.9).

С помощью инструмента  можно 
выполнять следующие операции ре-
дактирования объектов:

  Перемещение. Выделить объект. 
При появлении крестика из двунаправ-
ленных стрелок переместить объект.

  Изменение положения вершин. 
Подвести курсор к вершине и переме-
стить вершину.

  Изменение контура. Не выделяя 
контур, подвести курсор к контуру и 
переместить в нужном направлении.

(Рассмотрите пример 7.10.)
Многие операции изменения объек-

тов могут быть выполнены с помощью 
инструмента  Произвольная транс-

Пример 7.8. Инструменты выде-
ления:

 — Выбор (Selection);

 — Выбор подобласти 
(Subselection);

 — Петля (Lasso); 

 — Произвольная трансформа-
ция (Free Transform);

 — Перо (Pen Tool).

Пример 7.9. Выделение объектов.

Весь объект Заливка

Часть обводки
Все части 

обводки (с Shift)

Пример 7.10. Использование ин-
струмента .

                 
Перемещение

Изменение положения вершин

Изменение контура
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формация (Free Transform). При ра-
боте с инструментом  после выделе-
ния объекта на Панели инструментов 
становятся доступными кнопки выбора 
режимов: 

  Поворот и наклон (Rotate and 
Skew);

  Масштабирование (Scale);
  Искажение (Distort);
  Изгиб (Envelope).

(Рассмотрите пример 7.11.)
Пример 7.12 иллюстрирует измене-

ние объекта при использовании инстру-
мента Произвольная трансформация в 
разных режимах. Трансформация вы-
полняется с помощью маркеров, рас-
положенных на выделяющей рамке. 
Каждый маркер связан с определенной 
операцией. Разным маркерам соответ-
ствует свой вариант указателя мыши.

С помощью команд меню Изменить 
(Modify) можно выполнить операции 
над объектами:

  Преобразование (изменение разме-
ра, поворот, отражение и др.) — Транс-
формация (Transform);

  Группировку (объединение не-
скольких объектов в один) — Группи-
ровка (Group);

  Выравнивание (по горизонтали и 
по вертикали, относительно границ 
объектов и относительно центра) — 
Выравнивание  (Align).

Пример 7.11. Кнопки выбора ре-
жима для инструмента Произволь-
ная трансформация.

Исходное изображение

                 
                         Поворот                                Наклон    

                                             
Масштабирование                     Искажение

Изгиб

Пример 7.12. Использование ин-
струмента Произвольная трансфор-
мация.

Options

1.  Какие инструменты редактора Flash используются для рисования?
2.  В каком режиме инструмента Карандаш рисуются геометрические фигуры?
3.  Для чего предназначен инструмент Выбор?
4.  Какие преобразования объекта можно выполнить с помощью инструмента 
Произвольная трансформация?

?
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      Упражнения

   Откройте файл. Дополните изображение автомобиля. При 
рисовании окна используйте градиентную заливку. Скопируй-
те изображение окна, примените к копии операцию отраже-
ния. Сохраните изменения в файле.

   Создайте изображения, воспользовавшись рекомендациями.

Изображения Рекомендации

Используйте инструменты  и с настройками:

Примените инструмент  для преобразования линий 
в дуги либо нарисуйте дуги как часть окружности.

Для рисования используйте инструменты  и . Ин-
струмент  применяйте в различных режимах. Кор-
ректируйте изображение с помощью инструмента .

Копирование окон выполняйте, удерживая клавишу 
Shift.
Для изгиба дома используйте инструмент .
Скорректируйте контур с помощью инструмента .

Сохраните изображения в формате FLA.

   Нарисуйте одного из роботов. Для рисования используйте инструменты , , 

 и инструмент редактирования . Сохраните изображение с именем, соответ-
ствующим эмоции робота.
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